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Introduction to the Archive Configuration, Archive, and Restore Tools

The Archive Configuration Tool allows you to configure the system for archiving account data.
Configuration includes specifying the archive server, archive database, and which tables a user can
archive, view, and purge. Configure the system before attempting to archive or restore account data.

The Archive Tool allows you to archive account data to increase performance in your production
database by removing most of the data for older, returned accounts. Archiving moves most account data
from your Latitude database to an archive database that you or a Latitude by Genesys representative
created. The system doesn't archive all data it uses some data to open the account in the Work Form and
some data for financial accounting.

We recommend that you store the archive database on a different server than your Latitude database to
increase performance on the production server. Since the archived data is rarely used, you can store it on
a server with lower performance requirements, which can result in lowered data storage costs. If your
company uses more than one production database, set up a separate archive database for each
production database.

The Restore Tool allows you to restore archived account data. Restoring moves account data from the
archive database to your Latitude database. Once you restore account data, you can view it as you
normally would in the Work Form in Latitude.

Archive and restore permissions

The system requires the following permissions to allow you to archive and restore account data:
2. Access Archive/Restore Functionality

3. Enable Archive of Account Data

For more information about these permissions, see "Archive Permissions and Policies" in the Latitude
documentation.

Feedback

S GENESYS

What's New in Archive Configuration, Archive, and Restore Tools

The following Service Updates (SU) introduced changes and enhancements in the Archive Configuration,
Archive, and Restore Tools in 13.0:

SuU
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Help Overview

Archive Configuration, Archive, and Restore Tools help provides you with information for using the
Archive Configuration, Archive, and Restore Tools. To locate and view a topic, use the table of contents,
index, and search features.

To open help

Open the "\\Program Files (x86)\Interactive Intelligence\Interaction Collector\Documents" folder and
then double-click ArchiveAndRestore.chm.

[ Help System - o X
« > &
Hde Bsck Fowad Pt
Cortents Ihdu I Seachl 2 3 Mome | Help System A
) Help System S = .
L‘BW'st« o GENESYS 4 Feedback
) Logon
Book 1 Introduction 5
Book 2
Book 3 This graphic represents the help system layout

for Latitude by Genesys products.

Lorem ipsum dolor sit amet, vix id quot
aperiam sententiae, no mea definiebas
referrentur voluptatibus. Soluta meliore eu
mei, pro alienum legendos definitionem in,
sumo essent legendos ea vix, At vim veritus
senserit adversarium, has in dignissim
conceptam, el sit veritus accumsan. Te odio
urbanitas pri, tamquam honestatis vel ex, at
quo enim virtute,

Mei impetus saperet ea, no saperet
disputationi his. Nam diam quas appellantur
cu. Duo nonumy vituperata in. Nec ex saperet
civibus denique, quo dolorem consetetur eu,

Tip: To adijust the width and height of the window or its panes, click the edge of the window or pane
and drag it up or down, left or right.

3. Toolbar: Allows you to hide or show tabs and the Navigation pane, move forward and backward
through topics, and print the currently displayed topic.

4. Tabs: Displays the following:

Contents: Displays the table of contents. To display a topic in the Content pane, expand a book
and then click the link.

Index: Displays the index. To display a topic in the Content pane, type a keyword or phrase in the
box (or scroll through the list) and then click the link in the list.

Help Overview



Search: Displays the search feature. To display a topic in the Content pane, type a keyword or
phrase in the box and then press Enter. In the search results, click the link.

Glossary: If available, displays a list of terms and their definitions. To display a definition, click the
term.

4. Breadcrumbs: Displays your current location within the help system. When you click a
breadcrumb, the related topic displays.

5. Content toolbar: Displays an option to send feedback through an email message to Latitude by
Genesys Documentation.

6. Content pane: Displays the contents of a topic. To view the Content pane menu, right-click in the
Content pane.

Search feature

You can use the search feature to search for topics that contain words or phrases that you specify. You
formulate a search query following a specific set of rules. You can include wildcard expressions, Boolean
operators, and nested expressions in your search query. A list of topics that match your search criteria
appear in the search results. When you click a topic title in the search results, the content of that topic
appears in the Content pane.

Search syntax
The basic rules for formulating search queries are:
5. Searches are not case-sensitive, meaning you can type uppercase or lowercase characters.

6. You cannot search for a single character or the following reserved words: an, and, as, at, be, but,
by, do, for, from, have, he, in, it, not, of, on, or, she, that, the, there, they, this, to, we, which,
with, you.

7. The search engine ignores punctuation marks and special characters such as @#5$%"&()=+[]\.

8. Enclose phrases and terms that include a period (such as a file name with an extension) in
double quotation marks.

Wildcard expressions

Wildcard expressions allow you to search for one or more characters using a question mark or asterisk. A
guestion mark represents a single character, while an asterisk represents one or more characters.

Search for... Example |Result

Topics with text that starts with one or
more specified characters and ends in [log or log*
any character or number of characters

Returns all topics with text that starts with the
specified characters (for example, log, logon, logging).




Topics with text that starts with the
specified characters, has a single

32757

Returns all topics with text that has any character
where you placed the question mark (for example,
32?57 returns 32257, 32457, and 32857).
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character that can be anything, and
ends in the specified characters

Returns all topics with both account and status, but
account [not necessarily as a phrase or in the order specified.
status For example, the search returns topics with "the
account status..." or "the status of the account..."

Topics that contain all the words
specified, in any order or placement
within the topic

Returns all topics with account status as a phrase. For
example, the search returns topics with "the account
status..." but not "the status of the account..."

Topics that contain the specified "account
phrase status"

Boolean operators

Boolean operators (AND, OR, NOT, NEAR) allow you to create a relationship between terms. If you don't
specify an operator, the system uses AND by default.

Search
Example Result
for...
Returns all topics with both account and status, but not necessarily as a phrase or
account AND
AND . . . S
status in the order specified. For example, the search returns topics with "the account
status..." or "the status of the account..."
account OR
OR Returns all topics with either account or status, or both.
status
account NOT . .
NOT Returns all topics with account but not status.
status
account . .
NEAR Returns all topics where account is within eight words of status.
NEAR status

Nested expressions

Nested expressions allow you to perform complex searches. For example, queue AND ((collector OR
clerical) not supervisor) finds topics containing queue and collector but not supervisor, or containing
gueue and clerical but not supervisor. As with mathematical expressions, the system evaluates
expressions in parentheses first. If there is no parenthesis, the system evaluates the expression from left
to right. For example, queue NOT (clerical OR supervisor) finds topics containing queue but not clerical or
supervisor. Queue NOT clerical OR supervisor finds topics containing queue but not clerical, or topics
containing supervisor.

Related Topics

Introduction to the Archive Configuration, Archive, and Restore Tools

What's New in Archive Configuration, Archive, and Restore Tools
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Archive Configuration Tool

Use the Archive Configuration Tool to specify the configuration for archiving account data.

3 GENESYS ot

Log on to the Archive Configuration Tool

Use the Latitude Login dialog box to log on to the Archive Tool. To

log on to the Archive Tool

7. Click Start > All Programs > Interactive Intelligence > Interaction Collector > Archive Tools >
Archive Configuration Tool. The Latitude Login dialog box appears.

¢y Latitude Login E3

User Name: I|
Password: I
Database: IDefault Instance _'_l

I™ Login using Windows authentication
_once |
1. Inthe User Name box, type your Latitude user name.

2. Inthe Password box, type your Latitude password. As you type your password, periods display
instead of the typed characters.

Note: To log on using Windows authentication, select the Log in using Windows authentication
check box and provide your Windows user name and password.

2. Click Okay. The Latitude Archive Configuration Utility window appears.
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. Latitude Archive Configuration Utility

File  Help
Archive Server Archive User I<F!equired>
Archive Database |<F|equired> i s lxxxxxxxxxx
TableName | JoinColumn ParentT able ParentColumn Archive Viewable )
> number ICi l‘
B cetic:s number master number I [
Payhistary number master number [ [
notes humber master number v v
miscextra number master number v v
extradata number master number v v 1=
Debtordttormeys accountid master number v v
DebtorBanklnfo | acctid master number v v
Garnishment accountid master number v v
| PDC number master number v | v ‘ILI
4 »

pdate | Cancel |

Ll

First time configuration

3 GENESYS —

Specify Configuration for Archiving Account Data

Use the Latitude Archive Configuration Utility window to specify the configuration for archiving account
data.

To specify configuration for archiving account data

4. Open the Latitude Archive Configuration Utility window.

Archive Configuration Tool
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File  Help

Archive Server

Archive User

Archive Database |<Hequired>

Archive Password I

I<H equired>

RRRRRXRRHK

T ableName | JainCalumn ParentT able ParentColumn Archive Viewable )
h number [ |
i debtors number master number I (]
Payhistory number master number I [
notes number master number v v
miscexstra number master number v v
extradata number master number v v I
Debtordttormeys | accountid master number v v
DebtorBankinfo | acctid master number v v
Garnishment accountid master number v v
PDC number master number v v ‘[ﬂ
«| | »
ﬂ pdate I Cancel I
|_ First time configuration

Archive Server: Server where the archive database resides.

Archive Database: Name of the database to store archived account data.

Archive User: User ID for accessing the archive database.

Archive Password: Password for accessing the archive database.

Archive: If selected, the system archives the data in the corresponding production table.

Viewable: If selected, you can view the archived data in the Archive Tool.

Archive: If selected, the system purges the data in the corresponding production table after

archiving the data.

«  Complete the information and then click Update.

S GENESYS

Import Table Definitions

Use the Import Table Definitions dialog box to import table definitions into the archive table. The

import process overwrites the existing archive table definitions. To import table definitions

Feedback

5. In the File menu, click Import Table Definitions. The Import Table Definitions dialog box appears.
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‘O\ | v Usars = barbaramertin ~ My Documents ~ Lathude v ﬁl Saarch Lattude (2}

Organize v  Naw foldar = 39

o 2| Name - | oate modfied | 1ype |

B Desktop | ArchiveTableRelationship 7/19/2016 8:54 AM ML Dacument
B Dovnbads

%] Recent Places

4 Ubraries
%] Documents
&' Music
e Pictures
B videos

M Computer

ook (@) ) ) | »

File name: |chiveTableRelationship | [eMLFiles =

| Open I Cancel I

&~

1. Inthe Name column, click the name of the import file and then click Open. A confirmation dialog
box appears.

Latitude Archive Configuration Utility - Import Table Definitions

[X]

o Are you sure you want bo overwnte the current table definition

y !A with the contents of

- "C\Users\barbara.martin\DocumentsiLatitudel ArchiveTableRelati
onship.xml”

2. Click Yes.

3 GENESYS —

Synchronize the Archive Schema

Use Synchronize Archive Schema feature to synchronize the production database schema to the archive

database. Use this feature to ensure that your archive database has the latest changes to the production
database.

To synchronize the archive schema

4. In the File menu, click Synchronize Archive Schema. A progress dialog box appears. When
synchronization is complete, a notification dialog box appears.

Archive Configuration Tool



Freshed Synchronizng archive databacs tables.

100 X completed

Latitude Archive Configuration Utility E3®

lo Process completed successfuly,

)

5. Click OK.

3 GENESYS -

Export Table Definitions
Use the Export Table Definitions dialog box to export the table definitions in the archive table. To

export table definitions

« Inthe File menu, click Export Table Definitions. The Export Table Definitions dialog box

appears.
m "' + Users ~ barbara.martin + My Documents + Latitude v §23 | searchiotude g
Orgarize v New folder = v W
1| Recent Places :J Name - Ioatom&ied I‘lvpo |
Gl Uravies % ArchiveTabieRelationship 7/19/2016 8:54 AM XML Document
4| Documents
o' Music
5| Pictures
. Wideos
™ Computer
&5 Local Disk (C2)
=) ovD Drive (D:) GRP
& ooriveey =]l | 2
Fle name: | ArchiveTableRelationship] ~|
Save a5 type: [XML Fles ~]
* Hide Folders | Save I Cancel l
A

6. In the File name box, type a name for the export file and then click Save. The system exports the

table definitions to the specified file.

10
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View Archive History

Use the View Archive History dialog box to view the history of archive actions, such as configuration
changes and archiving of account data.

To view archive history

* Inthe File menu, click View Archive History. The View Archive History dialog box appears.

B View Archive History - (O] x]

File
Fom B19/2015 ¥| To | 7/19/2016 ¥] Action [l 2P Muses 60 |
' Date | User Action Description
Mgs 2 Iritialy created archive relationship
Qovasnale 12 |Acieidkiedissd
f- 7N32016957AM gs 2 |rshaly created archive relabonship
771372016 955AM | g 2 Initially created archive relfionship
! 7NS/2016 354 AM gs 2 Initialy created archive relabonship
| 7N19/2016 924 AM | gs 2 Irnehaly created archive relationship
 [771972016923AM | gs 2 Inifialy crested archive relationship
_——' 7H/2016 857 &M 'gs 2 Archive tables syncl‘wmzed N
7HNS2016 644 AM  gs 8 Accounts: 1lrwvabds: OProcessed: 1Elapsed Time [hhimmess
7N2ME644AM g 8 SELECT TOP 100 PERCENT|Mastes) [number]FROM [dbo)
 [771872016236PM |gs |16 |Accounts Tinvakds: OPvocessed: 1Elapsed Time (hhummss
 menm6235PM (s |16 SELECT TOP 100 FERCENT[Mastes] [numbedFROM [dbo]
;7/18/2018 156PM 'g: Accounts: 1lrvabds: 0Processed: 1Elapsed Time [hhimmess
| 7182016156PM (g SELECT TOP 100 PERCENT[Mastes] [rumber]FROM [dbo)
* |

M I uI
From: Start date for which to display information.
To: End date for which to display information.

Action: Action for which to display information.

All Users: If selected, displays information for all users. If cleared, displays information for the
current user only.

1. Complete the information and then click GO. The system displays the archive history for the
specified criteria.

Archive Tool
o

B GENESYS Festhact

11



Archive Tool

Use the Archive Tool to archive data for accounts that you specify. Only accounts with a 999" queue level
(returned) are eligible for archive.

3 GENESYS ot

Log on to the Archive Tool

Use the Latitude Login dialog box to log on to the Archive Tool. To

log on to the Archive Tool

2. Click Start > All Programs > Interactive Intelligence > Interaction Collector > Archive Tools >
Archive Tool. The Latitude Login dialog box appears.

1 Latitude Login E3

User Name: [|
Password: |
Database: IDefauIt Instance Ll

[T Loginusing Windows authentication
cocs
3. Inthe User Name box, type your Latitude user name.

4. Inthe Password box, type your Latitude password. As you type your password, periods display
instead of the typed characters.

Note: To log on using Windows authentication, select the Log in using Windows authentication
check box and provide your Windows user name and password.

4. Click Okay. The Latitude Archive window appears.

12
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B Latitude Archive _ (O] x]

File  Help
Select Accounts | Preview Results |

E'_j Clear | L,’-l Open HSave > | Count @ Run

#- ] Accounts
71 AM
@[] Champion Challenger
@ Comments
@ {71 Debt Forwarding
@ [~ Debt Purchasing
[ {71 Debtor Demographics
@ Dislers
& {71 Early Stage Data
#- Latitude Fusion
#-17 Legal
-7 Letters
[+ {7 Money Bucksts
[+ Patient Information
[#- {1 Payments
- PortfclioContacts
@ {1 Porticlios
@ {71 Post Dates
@ {21 Promises
@ {21 Restrictions
@ {1 Services_|dinfo_Bankruptcy
@ 7] Work Strategies
&7 Blank Literal Condtion

[T Exclude Duplicate Records

™ Maximum Records [_“—'———_3
t 35 B A =15

Lrag and arop new columns o

suiace AI
-

TR 4SS BREC ®®
Account is not archived ;l

and Account has been closed and returned
and Meets Retumed Date Policy of -1 Months Ago

=
X & 5| 423

Diag and drop new cotimns onlo the swiace

Le

-

Bl 1

Exe

S GENESYS

~ |os| o7/1816 01:00:32 P04

Feedback

Select Accounts to Archive

Use the Select Accounts tab in the Latitude Archive window to select the accounts to archive.

Note: These instructions are for creating a query. You can also open an existing query to select
accounts. For more information about working with queries, see "Queries" in the Latitude
documentation.

To select accounts

13

5. In the Latitude Archive window, click the Select Accounts tab.

Archive Tool
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File  Help
Select Accounts | Praview Results |

';*TZ] Cler | || l Open HSave 2 | Count Run

] Accounts

] AM

["] Champion Chalenger
"] Comments

Debt Foarwarding

ICRCRrE

+

S[=] B3

[T Exclade Duplicate Records
l o 3:

™ Maximum Records

B Select Columns

) Debt Purchasing x 4 [—", ‘ = Vx| -
D) Debtor Demographics
& Dialers Drag and dtop new columns onfo thes :J
371 Early Stage Data
& Latitude Fusion #l
[+ Legal
- Leters
+- (L1 Money Buckets " ' = =
+- {7 Patient Information 4 x ™ '} ,:_L;'l | € @ @
". F’aylne.nls Account is not archived ;I
'_ ;":T Poflfol!oConlacls and Account has been closed and returned
%14 Portolios and Meets Retumed Date Policy of -1 Months Ago
@ (i Post Dates
& {_4 Promises ;l
@ {_4 Restrictions
-1 Services_Idnfo_Benkiuptey
3 [ Work Strategies S W 2 m=

- 3 S o

&7 Blank Literal Condtion x o ‘ is A 1

Execute

| gs | 07/18/16 01:00:32 PM

The system sets three conditions by default; however, you can delete them.
1. To exclude duplicate records from the query results, select Exclude Duplicate Records.

2. To limit the query results to a specific number of records, select Maximum Records and then, in
the box, type the maximum number of records to include in the results.

3. Inthe Select Columns pane, do the following as necessary to specify the data columns to include
in the query results:

Drag and drop one or more data items into the Select Columns pane.

Arrange the order of the columns.

In the Conditions pane, do the following as necessary to specify the query conditions:
Drag and drop one or more conditions into the Conditions pane.

Arrange the order of the conditions.

Group conditions for evaluation.

In the Order pane, do the following as necessary to specify the sort order for the data returned
in the query results:

Drag and drop one or more data items to use to sort the query results into the Order pane.

Arrange the order of the data items.
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3. Click the data item and then click the Ascending or Descending icon.

2. To count the number of records that match the selection criteria, in the toolbar, click Count. The
results appear in the Query Designer dialog box. Click OK.

3. To save the query, do the following:

1. In the toolbar, click Save. The Save Query Dialog box appears.
SaveQueyDidog .. ol
Look In: My Queries - | M Delete | % Export To Fle
Name | Date Created |
Accounts is Parent 12/14/2012
Account Status is Open 12/18/2012

« Inthe Query Name box, type a name for the query and then click Save.

| Tip: To overwrite an existing query, in the Name column, click the query to overwrite and then
click Save.

« Click Run. The query results appear on the Preview Results tab.

3 GENESYS s

Archive Account Data

Use the Preview Results tab in the Latitude Archive window to review the accounts selected for archive,

and then archive the data for those accounts. To archive account data

* After running a query, in the Latitude Archive window, click the Preview Results tab. The
results appear in the data grid.

Archive Tool

15



B Latitude Archive
File  Help
‘Select Accounts  Preview Results |

=1 E3

)m ag a column header here 1o group by that Imn .."l. l-l-“-. .ll |-|.l| "--I | .l.l.- " l“.l"-.
‘\ number fink Name Stest] Strest2 City State Zipcode 2
i 0000000 Smith, Patnca 123 Main Streel J ONVILLE 32256

1234 0000000 Rolirs, Kathy 56 North Charle. COLUMBUS OH

1244 0000000 JONES, PATRI.. 569 BLAKE RO.. APTK COLUMBUS OH

1327 0000000 HILAND, JENNI..

1355 0000000 RIDDLE. KATHY 233 MANDY RO JACKSONVILLE  FL 32256

1710 EXCHDESK TERWILLEGER,.. 628 E GLASS A_ JACKSONVILLE  FL 32256

m EXCHDESK KOSTELSKI.JOY 1030 TREELINE. JACKSONVILLE  FL 32256

1712 EXCHDESK HILTON, CARRIE 2160 KNIGHTS JACKSONVILLE  FL 32256

1713 EXCHDESK MARX, SHANE 271E RIVERVIE JACKSONVILLE  FL 32256

1714 EXCHDESK STEFANO, FRA. PO BOX 2204 JACKSONVILLE  FL 32256

1715 EXCHDESK HEYER, MOLLY 124 LARCHMO. JACKSONVILLE  FL 32256

1716 EXCHDESK POLITO,ANGIE 311 CENTER ST JACKSONVILLE  FL 32256

1717 EXCHDESK KING, ERICK 1312 WEBSTER.. JACKSONVILLE  FL 32256

1718 EXCHDESK GAY, PAMELA 605 LOWRY AVE JACKSONVILLE  FL 32256

1719 EXCHDESK HINES. QUINTIN 7338 W 7TH 92. JACKSONVILLE  FL 32256
1740 EXCHDESK GERBER, CARL. 147 WALNUT S.. JACKSONVILLE  FL 32256

70 EXCHDESK NANTOM, DEB.. 52 ELDERBERR.. JACKSONVILLE  FL 32256

1742 EXCHDESK WILSON. TIM 178 BEREAU DR JACKSONVILLE  FL 32256

1743 EXCHDESK MEYERS, DON.. 111 MAGNOLIA. JACKSONVILLE  FL 32256

1744 EXCHDESK WASHINGTON,.. 965 GREENTRE JACKSONVILLE  FL 32256

1745 EXCHDESK LANDON, COO.. 310 CHARLES . JACKSONVILLE  FL 32256 _';'
¢| | »

Execute

[Preview: Completed succossﬂ:ly.

gs | 07/18/1601:14:19PM

The columns that appear are based on the ones you specified when you selected accounts.

Click Execute.

* Inthe confirmation dialog box, click Yes. The system archives data for the accounts and
then displays a notification dialog box.

*  Click OK.

* If errors occur during the archive, click the Exceptions tab.

B Latitude Archive

Fie  Help
' Select Accounts | Preview Results  Exceptions |

to group by that

codmn 'II I I. l I II I I I I Il

Execute I

Tas | 07/18/16 01:51:22 PM

| !

Note: To print or save the exceptions to a file, use the Print Exceptions or Save Exceptions option
in the File menu.

16
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View Archived Data

Use the Latitude Archive View File Number window to view archived data for an account. To

view archived data

* Inthe File menu, click View Archived Data. The Archive Data View dialog box

appears.
Entes the file number for the archived data you
ik e o i

1. In the box, type the file number of the account to view and then click OK.

£ Latitude Archive View File Number: 100328

ulD number ctl | created user action | resul comment IzPrvate UtcCre
0328 | SY Paid Us 100.00
10/18/2007 Status Changed .. =]
i 1819 100328 10/18/2007  nan co co Overpayment fu.. @ 1019/
! 1826 100328 10/18/2007  SYS eree rears Paid Us Transfer.. =] 1019/
: 5168 100328 11/28/2007  nan e et Account Returne.. O 11728/
47185 100328 LNK 02/12/2009 SYSTEM LINK NEW This account link.. =] 0212/
54231 100328 06/02/2009  nan ARCHY  OK Account has bee.  [@]  06/03/
i 54394 100328 06/04/2009  nan RSTOR OK Account ha: bee.. ® 06/04/
< v | >

File Number: 100328

1. Click the tabs to view the data.

Restore Tool

3 GENESYS —

Restore Tool

Use the Restore Tool to restore archived account data to your Latitude database.

S GENESYS st
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Log on to the Restore Tool
Use the Latitude Login dialog box to log on to the Restore Tool. To

log on to the Restore Tool

1. Click Start > All Programs > Interactive Intelligence > Interaction Collector > Archive Tools

> Restore Tool. The Latitude Login dialog box appears.

#v Latitude Login E3

User Name: "

Password: |

Database: |Default Instance ~

[T Login using Windows authentication
cocs_|

1. Inthe User Name box, type your Latitude user name.

2. Inthe Password box, type your Latitude password. As you type your password,
periods display instead of the typed characters.

Note: To log on using Windows authentication, select the Log in using Windows authentication
check box and provide your Windows user name and password.

a. Click Okay. The Latitude Archive Restore window appears.

18
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B Latitude Archive Restore !Em
Fie Help
Select Accounts | Preview Results |

P Cleal":: _ Open HSave ‘ZI‘Cm bﬂun
g 2 - J

= gj :l‘;;o"‘m"’ [T Exchade Duplcate Records

®C -

[# (-] Chamgion Chalenge: ™" Masimum Records ﬁ'—“_————a

-4 Cosanenis
[# (] Debt Foewarding ; n

(& (] Debt Purchasing x 1 J'} = | || ~

[+ ] Debtor Demographics - . ==

& Kj Digers rag and @drop mesy columns oo v suwvace 3
(+-{] Early Stage Data

-] Lattude Fusion =l
= Legal

- Letrs
#- ] Money Buckets oo 7 I it =] (

#- ) Patient Infoemation 77X 48 REE ®®

OF # Payments Account is achved =
- ] PortfolicContacts

# {l Porfolios

# (] Post Dates

® {7 Promises

¥ ] Restrictions

& (7 Senaces_ldinfo_Bankruptcy IR Order

[*)- [ Work Strategies o B ol B2
&7 Blank Lieral Condtion x | 3 'E L &

IL

| Lrag and arop mew Columns Ome N swlacs

1

[ |Loggedin [os | 07/18/16 02:22:17 PN

3 GENESYS —

Select Accounts to Restore

Use the Select Accounts tab in the Latitude Archive Restore window to select the accounts to restore.

Note: These instructions are for creating a query. You can also open an existing query to select
accounts. For more information about working with queries, see "Queries" in the Latitude

documentation.

To select accounts

—In the Latitude Archive Restore window, click the Select Accounts tab.
Restore Tool
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IR Latitude Archive Restore H=] E3
Fie Help
Select Accounts I Preview Results |

¥J Clear | "_. _ Open HSave _E_I Count L>,’> Run

e “ .:'c;;oun!s [T Exchade Duphcate Records
+ [l Chamgion Chalenges I™ Masmum Records | 10t 3
¥ LA Comments B Select Columns B
¢ (| Debt Forwardng .
s (] Debt Purchasing x 4 J} | &) -
- [] Debtor Demographics =
%] Diders Drag and drop <]
-] Early Stage Data
=) Lathuds Fusion

ki 5
+1- 4 Legal —j
#1- L1 Money Buckets . m = = A

~ y a J M | " y
-] Patient Infoemation P4 x g ; | [ i) § = )
oL Payments Account is achved =]
+ -l PortfolioContacts
+ ] Portfclios
% [0 Post Dates
) {7 Promises ~|
- [ Restrictions

LA
- (1 Services_drfo_Barkngptcy
- [ Work Strategies & A i Az

£/ Blank Lieral Condtion x i o | ¥4 8%

Execute
|Logged in os | 07/18/16 02:22:17 PM

The system sets one condition by default.

To exclude duplicate records from the query results, select Exclude Duplicate Records.

To limit the query results to a specific number of records, select Maximum Records and then,
in the box, type the maximum number of records to include in the results.

In the Select Columns pane, do the following as necessary to specify the data columns to
include in the query results:

o Drag and drop one or more data items into the Select Columns pane.

o Arrange the order of the columns.

« In the Conditions pane, do the following as necessary to specify the query conditions:

1. Drag and drop one or more conditions into the Conditions pane.
2. Arrange the order of the conditions.
3. Group conditions for evaluation.
1. In the Order pane, do the following as necessary to specify the sort order for the data returned in

the query results:

1. Drag and drop one or more data items to use to sort the query results into the Order
pane.
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2. Arrange the order of the data items.
3. Click the data item and then click the Ascending or Descending icon.
1. To count the number of records that match the selection criteria, in the toolbar, click Count. The

results appear in the Query Designer dialog box. Click OK.

2. To save the query, do the following:
1. In the toolbar, click Save. The Save Query Dialog box appears.
SaveQueyDidleg =
Look In: |My Queries = | M Delete ' % Export ToFie
Name | Date Created |
Accounts s Parent 12/14/2012
Account Status is Open 12/18/2012

1. In the Query Name box, type a name for the query and then click Save.

| Tip: To overwrite an existing query, in the Name column, click the query to overwrite and then
click Save.

1. Click Run. The query results appear on the Preview Results tab.

3 GENESYS s

Restore Archived Account Data

Use the Preview Results tab in the Latitude Archive Restore window to review the accounts selected for
restoring, and then restore the data for those accounts.

To restore archived account data

1. After running a query, in the Latitude Archive Restore window, click the Preview Results tab. The
results appear in the data grid.

Restore Tool
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B Latitude Archive Restore 5l
Fie Help
Select Accounts  Preview Results I

imn header here to group by that colurm

Street]

Smith, Patica 123 Main Street

JACKSONVILLE FL

Execute
[ gs | 07/18/16 02:30:41 PM

The columns that appear are based on the ones you specified when you selected accounts.
Click Execute.

In the confirmation dialog box, click Yes. The system restores archived data for the accounts and
displays a notification dialog box.

Click OK.

If errors occur during the restore, click the Exceptions tab.

£ Latitude Archive Restore !E m
File  Help
Select Accounts | Preview Resuts  Excepbons |

| FileNurmber | Message

ag a column header here 19 group by that column

Error creating datatable from =ml <miException) Root element 1 missing

[ 1 Error generating the restore table list from the archive database (NullReferenceExcept. Restore
i 1233 ERROR: Logn fated for user 13D0OMAIN\Barbara Martey’ Restore
|
Execute

I [gs | 07/18/16 02:38:40 PM

Note: To print or save the exceptions to a file, use the Print Exceptions or Save Exceptions option
in the File menu.
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